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Document Summary

Part |

EEO-1 Component 2 Pay Data Filing Overview

Part Il

eCMS Instructions for Setup, Processing and CSV Filing
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Part | — EEO-1 Component 2 Facts

What’s New
EEOC is collecting compensation data for 2017 and 2018

Report collects the number of employees and hours worked

by Job Category, Salary Pay Band, Gender, Race/Ethnicity

Filing Deadline — September 30, 2019
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Component 2 Reporting Highlights

Two Options to Report 2017 & 2018 Survey Years
Manually Enter Data Online Form

Upload CSV Files — eCMS is Designed to Create the File

Establishments

Single or Multiple Locations

Workforce Snapshot Pay Period
One Pay Period Between Oct 1 and Dec 31 of the Reporting Year

Smarter Construction. Cloud ERP. ﬁm {F g




Component 2 Highlights Reporting Highlights

Report Employees by
Job Category, Pay Bands, Minority Codes and Gender

Report Hours Worked
by Employee in Their Job Category & Pay Band

The EEOC has contracted with NORC at the University of Chicago to collect the Component 2
EEO-1 data for 2017 and 2018:

Smarter Construction. Cloud ERP. ﬁm {F g




Component 1 versus Component 2
from EEOC Component 2 EEO-1 User’s Guide

Component 1 - Information Collected
Employee Counts by:
Race/ethnicity groups by gender and
EEO-1 Job Category

Employer selected workforce snapshot period

Due Date: May 31, 2019

Component 2 (New) - Information Collected
Employee Counts and Hours Worked data by:
Race/ethnicity groups by gender;
EEO-1 Job Category; and
Annual pay by Compensation band

Employer selected workforce snapshot period

Due Date: September 30, 2019

COMPUTER
GUIDANCE
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More Information to Support Filing

from EEOC Component 2 EEO-1 User’s Guide

Home Federal Register Notice April 25 Court Order FAQs Contact Us LOSIN
to File

MORE INFORMATION TO SUPPORT FILING

The following materials and information are available to help support Component 2 EEO-1
Compensation Data filing.

v Sample Form - the proposed EEO-1 Form to collect pay data in the Component 2 EEO-1 Online Filing System.
Instruction Booklet for Filers - instructions for submitting the Component 2 EEO-1 Report.
User's Guide - instructions for using the Component 2 EEO-1 Online Filing System.
Fact Sheet for Component 2 EEO-1 Report Filers - a list of important deadlines, reminders, and definitions
to support a successful submission of Component 2 data for 2017 and 2018 calendar years.

Upload File Specifications - instruction for developing Component 2 EEO-1 upload files so employers may
prepare in advance of the upload system availability.

Upload File Validation Process - explanation of the validation process, validation rules, and possible error
messages filers may encounter during the fiing process.

Component 2 EEO-1 Compensation Data Collection Initial Notification  the USPS letter senton July 1.
2019 to notify companies of the immediate reinstatement of the revised Component 2 EEO-1 collection for
2017 and 2018.

Reference Documents - supporting reference maternials including the job classification guide, 2017 NAICS
codes. a Postal Code Lookup file.

Component 2 EEO-1 User’s Guide Version 3_Aug2019, Page 65

Visit the More Info section
of the Component 2 Online
Filing System website for
links to reference materials
and more information to
assist employers with
Component 2 EEO-1 filing.

88 PDPAJJCE:E Smarter Construction. Cloud ERP.




Additional Reference Documentation
from EEOC Component 2 EEO-1 User’s Guide

:zfz"etzér:‘eal Home Federal Register Notice April 25 Court Order FAQs Contact Us
Reference

Documentation

section of the ADDITIONAL REFERENCE DOCUMENTATION

Component 2 Online
Filing System
website, additional
documents are
provided to support
filing.

+ EEO-1Job Classification Guide (Excel)
v 2017 NAICS Codes and Descriptions (Excel)
 Postal Lookup Spreadsheet (Excel)

Component 2 EEO-1 User’s Guide Version 3_Aug2019, Page 66
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Help Desk Information
from EEOC Component 2 EEO-1 User’s Guide

For questions regarding the Component 2 EEO-1 Online Filing System,
contact the NORC HelpDesk:

= Email: EEOCcompdata@norc.org
= Toll Free: 877.324.6214
= Hours: Monday — Friday, 8 am — 7 pm CST

Latest Update: 9/17/2019 — The Component 2 EEO-1 HelpDesk hours have been extended to better accommodate
the high volume of daily calls and emails. The updated Central Time hours are Monday through Friday, 8 am - 8 pm;
Saturday, 10 am - 4 pm; and Sunday, 12 pm - 5 pm. We appreciate your patience as the HelpDesk agents work
through the many requests for guidance or support.

Component 2 EEO-1 User’s Guide Version 3_Aug2019, Page 67
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How do Employers File?
from EEOC Component 2 EEO-1 User’s Guide

1. Receive a User ID from NORC via
a) letter mailed through USPS, and
b) email to the registered EEO-1 email address on record.

2. Visit the Component 2 EEO-1 Online Filing System https://eeoccomp?2.norc.org/

to log in using the User ID provided in the letter and/or email

3. File and certify reports through the Online Filing System.

COMPUTER
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Filing Options
from EEOC Component 2 EEO-1 User’s Guide

The EEOC Component 2 EEO-1 Compensation Data Collection offers employers two options to report their 2017 and 2018 pay and
hours worked data through the Component 2 EEO-1 Online File System (https://eeoccomp?2.norc.org)

1. Manually enter data into an online form

2. Upload Data via Comma Separated Value (CSV) file

eCMS Will Create the CSV File

Given the number of data items required in Component 2 report the EEOC has designed a new narrow file layout

COMPUTER
GUIDANCE
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Workforce Snapshot Period
from EEOC Component 2 EEO-1 User’s Guide

Employers will select a pay period between October 1 and December 31 of the reporting year, known as the workforce snapshot
period.

The workforce snapshot period for the 2017 EEO-1 report would be an employer-selected pay period between October 1, 2017
and December 31, 2017.

The workforce snapshot period for the 2018 EEO-1 report would be an employer-selected pay period between October 1, 2018
and December 31, 2018.

The only employees whose compensation and hours-worked data must be reported are those full-time and part-time employees
who were on the employer’s payroll during the employer-selected workforce snapshot period.

Note: The Workforce Snapshot Period for 2017 and 2018 can be the same or different pay periods

COMPUTER
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Job Categories
from EEOC Component 2 EEO-1 User’s Guide

Executive/Senior Level Officials and Managers
First/Mid-Level Officials and Managers
Professionals

Technicians
Sales Workers Job Categories are EEO Categories in eCMS

Administrative Support Workers See Part Il Slides 40 through 44 for Mapping
Craft Workers

Operatives 7

Laborers and Helpers

O 0N o Uk WNRE

10. Service Workers

See the EEO-1 Job Classification Guide on the Additional Reference Documentation section of the Component 2 EEO-1 Filing
System for examples of job titles in each category.

COMPUTER
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Race/Ethnicity Groups
from EEOC Component 2 EEO-1 User’s Guide

Hispanic or Latino

White

Black or African American

Native Hawaiian or Other Pacific Islander
Asian See Part Il Slides 36 through 39 for Mapping

Race/ Ethnicity Groups are Minority Codes in eCMS

Native American
Alaska Native
Two or More Races

O NV WNE

Employee self-identification is the preferred method of identification for the race/ethnicity categorization of employment data.
Employers are required to attempt to allow employees to use self-identification to complete the EEO-1.

If any employee declines to self-identify, employers may consult with employee provided information when on-boarded or the employer may
use visual observation

COMPUTER
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Compensation Bands
from EEOC Component 2 EEO-1 File Website

No individual pay information for employees will be Compensation Compensation Band
reported in the Component 2 EEO-1 report.

Band Range

1 $19,239 and under
The 12 compensation bands listed here are used to 2 $19.240 - $24,439
report a compensation range for each employee. 3 $24,440 - $30,679
4 $30,680 - $38,999
. . 5 $39,000 - $49,919
Employers should refer to earnings reported in W-2
. . 6 $49,920 - $62,919
Box 1 when selecting a compensation band for
7 $62,920 - $80,079
each employee.
8 $80,080 - $101,919
9 $101,920 - $128,959
This Ijeference should be used even if the employee 10 $128.960 - $163,799
did not work a full year. y $163.800 - $207,099
12 $208,000 and over

COMPUTER
GUIDANCE

Smarter Construction. Cloud ERP.



Reporting Total Hours Worked
from EEOC Component 2

Employers should| report total hours worked during the year|for those employees counted during the employer-selected pay
period, also known as the workforce snapshot period, for the calendar year (2017 or 2018).

Data will only be reported for full-time and part-time employees who were on the employer’s payroll during the workforce
snapshot period.

Non-exempt employees: Under the Fair Labor Standards Act (FLSA), the EEOC is requiring that employers enter data on actual
hours worked.

Exempt employees: Employers have the option to enter actual hours worked or proxy hours worked:

» Report actual hours worked by exempt employees if the employer already maintains accurate records of this information;
or

» Report a proxy of 40 hours per week for full-time exempt employees and 20 hours per week for part-time exempt
employees multiplied by the number of weeks the employees are employed during the EEO-1 reporting year.

COMPUTER
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Upload and Validate Data File Process
from EEOC Component 2 EEO-1 User’s Guide

Before proceeding with the file upload process, please be sure you have carefully reviewed and followed the instructions in these
supporting documents to create your Component 2 EEO-1 upload file(s):

Upload File Specifications — https://eeoccomp2.norc.org/info - Instructions for developing upload files.

Upload File Layout Specifications — https://eeoccomp2.norc.org/additional-reference - File layout in Excel format.

Upload File Validation Process — https://eeoccomp2.norc.org/info - Overview of the validation process, validation rules, and
list of error messages.

Use the links above or refer to User’s Guide Page 45-46 for the location of these files on the Component 2 EEO-1 site.

COMPUTER
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Upload and Validate Data File Process
from EEOC Component 2 EEO-1 User’s Guide

The data field upload process in Component 2 EEO-1 Filing Online System Consists of 5 main steps:

1. Select filing year
2. Select data file for upload
3. Upload and validate the data file = Instructions and

- Examples can be
4. Review the Upload Summary P . in the EE0-1
5. Report employer-level data and certification information User Guide

Enter employer-level information including:

The company name, address, FEIN
Enter employer-level information including:
Employer-Selected Workforce snapshot period for the report year, and answer the requiring eligibility questions
COMPUTER
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Data File Structure
from EEOC Component 2 EEO-1 File Website

In the Component 2 EEO-1 upload file layout columns in the file are:
Job Category
Demographic Group (defined by race, ethnicity, and gender)
Annual Salary as reported by Pay Bands
Along with Number of Employees and Hours Worked.

Each record in the upload file represents a unique combination of “job category by demographic group by pay band” for each
establishment.

This will result in a longer file, but it will be narrower and more efficient

Empty records are not reported. J

One file layout supports all report types.

COMPUTER
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Data File Structure
from EEOC Component 2 EEO-1 File Website

Once a data file has been uploaded into the Component 2 EEO-1 Online Filing System and has been validated by the system, filers
will be asked to report additional employer-level information and certify the report.

See the slides 30 though 33 for, “Additional Reporting Requirement to Certify Uploaded Files” for a list of the data to be reported
in the Online Filing System after data upload.

A separate upload file is needed for each 2017 and 2018 and employer-level data and certification will need to be reported for
each year, as well.

COMPUTER
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Upload File Specification
from EEOC Component 2 EEO-1 File Website

The File Layout for the Component 2 is a Comma Separated Value file — CSV

Data Set Name Specification:

Upload File yyyyCCCCCCCC, where 'yyyy' is the survey year, 2017 or 2018, and "CCCCCCC" is the 8-digit User ID provided by
NORC.

Data Description:

The Component 2 EEO-1 upload process requires all establishments to be uploaded as part of the same file regardless of
whether any establishments have fewer than 50 employees.

This is different than Component 1 where establishment with fewer than 50 employees are reported as part of a separate file.

COMPUTER
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Upload File Specification
from EEOC Component 2 EEO-1 File Website

Component 2 EEO-1 reports for single and multi-establishment employers are designated by Status Code (column 2).

The following Status Code are Supported by eCMS:

Single Establishment Employers

Status Code 1 = Single Establishment Company

COMPUTER
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Upload File Specification
from EEOC Component 2 EEO-1 File Website

Multi-Establishment Employers
Must Minimally File
Type 3 Headquarters Report — Status Code = 3
And at least one of the following Reports:

Type 4 Individual Establishment Report for locations with 50 or more employees - Status Code = 4

Type 8 Individual Establishment Report for locations with fewer than 50 employees - Status Code = 8

COMPUTER
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Upload File Specification
from EEOC Component 2 EEO-1 File Website

Multi-Establishment Employers
(continued)

Order of Type Status Codes in File
Status Code 3 = Headquarter first

Status Codes 4 or 8 = All Establishments exception of Headquarters middle

COMPUTER
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Upload File Layout for 2017 and 2018

from EEOC Component 2 EEO-1 File Website

TABLE 1. EEOC Component 2 EEO-1 File Layout for 2017 and 2018 (Download as an Excel File)
GO | FIELDICOLUMN NAME LENGTH | TYPE* VALUES, REMARKS, AND OTHER INSTRUCTION REQUIRED
1 USERID 8 &M | UNIQUE 8-DIGIT IDENTIFIER FOR ENTIRE COMPANY PROVIDED BY NORC TO EMPLOYER Yes
2 STATUSCODE 1 M INDICATES TYPE OF REPORT AS INDICATED IN PART A OF EEOC STANMDARD FORM 100: Yes
1 = SINGLE-ESTAB EMPLOYER MULTI-ESTAB
2 = CONSOLIDATED REPORT
3 = HEADOUARTERS REPORT
4 = ESTABLISHMENT REPORT {50+ EMPLOYEES - NOT FIRST TIME REPORTING)
5 = SPECIAL REPORTING PROCEDURE
& = STATUS CODE & REPORT (LESS THAN 50 EMPLOYEES)
8 = STATUS CODE & REPORT (LESS THAN 50 EMPLOYEES)
8 = STATUS CODE 8 REPORT (GREATER THAN 50 EMPLOYEES - FIRST TIME REPORTING)
MORE REPORT TYPE INFORMATION (PAGE 4):
https:/iescccomp2. nore. crg/assete/documents/Comp2EE O InstructionBook. pdf
3 UMITNUMBER 7 AN s . . .
[ Field is to be blank in the file — You can enter 1234567 to get through the selection screen
4 UMITNAME 35 AM | ESTABLISHMENT MAME Yes

GUIDANCE
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Upload File Layout for 2017 and 2018

from EEOC Component 2 EEO-1 File Website

ﬁﬁ;ﬂ: FIELD/COLUMN NAME LENGTH | TYPE* VALUES, REMARKS, AND OTHER INSTRUCTION REQUIRED
UNITADDRESS 46 AN ESTABLISHMENT ADDRESS Yes
6 UNITADDRESS2 25 AN Field is to be blank in the file Mo
7 CITY 28 A CITY NAME g
B STATE 2 A FIPS PUB 5-2 (CENSUS) g
STATE ABBREVIATOM, VALID VALUES ARE 50 STATES PLUS DC, LOOK UP INFORMATION:
hitps:lieeoccompe norc. or/additional-reference himil
] ZIPCODE 5 M 1.5, POSTAL SERVICE ZIP CODE Yieg
WOTE: UPLOAD FILES CONSTRUCTED IN EXCEL SHOULD FORMAT THIS FIELD AS TEXT
TO ENSURE ANY LEADING ZEROS (0) ARE PRESERVED WHEN THE FILE 1S CONVERTED
TO CSY FORMAT. 5-DIGIT NUMERIC VALUES ARE EXPECTED IN THIS FIELD.
ZIP CODE LOOK UP INFORMATION:
hittps feeoccomp2 norc.org/additional-reference. him
10 COUNTYNAME 28 AN COUNTY NAME LOOK UP INFORMATION: hitps.//eeoccomp?.norc.org/additional-reference. himl Yes
COMPUTER Smarter Construction. Cloud ERP.
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Upload File Layout for 2017 and 2018

from EEOC Component 2 EEO-1 File Website

ﬁﬁ;ﬂ: FIELD/COLUMN NAME LENGTH | TYPE* VALUES, REMARKS, AND OTHER INSTRUCTION REQUIRED
b FEIM j M YOUR FEDERAL EIN (TAX ID) 8 DIGITS Yes
12 NAICSCODE f N NAICS CODE LOOK UP INFORMATION: hitps/lesoccomp? nore.org/addiional-reference him Yasg
TYPE 6 REPORTS USE 089999
13 QUESTIONB2C i M WAS AN EEQ-1 REPORT FILED FOR THIS ESTABLISHMENT LAST YEAR? 1=YES; 2=NO s
14 QUESTIOND? i N |5 THIS ESTABLISHMENT: (1) NOT EXEMPT AS PROVIDED FOR BY 41 CFR60-1.5; (2) A PRIME Yo
CONTRACTOR OR FIRST-TIER SUBCONTRACTOR; AND (3) HAVE A CONTRACT,
SUBCOMTRACT, OR PURCHASE ORDER AMOUNTIMG TO $50,000 OR MORE: OR SERVE AS A
DEPOSITORY OF GOVERMMENT FUNDS [N ANY AMOUNT: OR 15 A FINANCIAL INSTITUTION
WHICH IS AN [SSUING AND PAYING AGENTS FOR U5, SAVINGS BONDS AND OR SAVINGS
NOTES? 1=YES; 2=NO
COMPUTER

GUIDANCE
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Upload File Layout for 2017 and 2018

from EEOC Component 2 EEO-1 File Website

ﬁﬁ;‘;’:: FIELD/COLUMMN NAME LENGTH | TYPE* VALUES, REMARKS, AND OTHER INSTRUCTION REQUIRED
15 JOBCATEGORY 2 N JOB CATEGORY CODES ARE AS FOLLOWS: Yes
1: EXECUTIWE/SENIOR LEVEL OFFICIALS AND MAMAGERS (Line No. 1.1, Section D, on EEC-1
Form)

2: FIRST/MID-LEVEL OFFICIALS AND MANAGERS (Line No_ 1.2 | Section D, on EEQO-1 Form)

3: PROFESSIONALS

4: TECHNICIANS

5: SALES WORKERS

6 ADMIMISTRATIVE SUPPORT WORKERS

T: CRAFT WORKERS

8: OPERATIVES

9: LABORERS AND HELPERS

10: SERVICE WORKERS

99: NOT APPLICABLE (TYPE & REPORT OMLY)
SEE EEO-1 JOB CLASSIFICATION GUIDE:

hitps:ifesoccomp?. norc_orgfadditional-reference. him

16 RACEETHNICITYGENDER 1 A RACEETHNCITY/GENDER CODES ARE AS FOLLOWS: Yes
A: HISPANIC or LATING MALES

B: HISPANIC or LATING FEMALES

C: WHITE MALES

D: BLACK or AFRICAN AMERICAN MALES

E: NATIVE HAWAIIAM or OTHER PACIFIC ISLANDER MALES

F: ASLAN MALES

G: MATIVE AMERICAN or ALASKA MATIVE MALES

H: TWO or MORE RACES MALES

I: WHITE FEMALES

J: BLACK or AFRICAN AMERICAN FEMALES

K: NATIVE HAWAIIAM or OTHER PACIFIC ISLANDER FEMALES
L: ASIAN FEMALES

M: MATIVE AMERICAN or ALASKA NATIVE FEMALES

MN: TWO or MORE RACES FEMALES

Z: NOT APPLICABLE (TYPE 6 REPORT ONLY)

COMPUTER
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Upload File Layout for 2017 and 2018

from EEOC Component 2 EEO-1 File Website

COLUMN

NUMBER FIELD/COLUMN NAME LENGTH | TYPE® VALUES, REMARKS, AND OTHER INSTRUCTION REQUIRED

17 ANNUAL SALARY 2 M PAY BAND CATEGORY CODES ARE AS FOLLOWS: Yes
1: $19,239 and under

20 519,240 - 524 438

3 524 440 - 530,679

4: 530,680 - $38,998

5. $38,000 - 549919

6: 548,920 - 562 919

7: 562 820 - 580,074

8: 580,080 - 5101919

- 5101,920 - 5128958

10: $128 960 - $163,799

11: $163,800 - 5207 999

12: $208,000 and over

99: Total Employees (TYPE 6 REPORT OMLY)

2]

18 TOTALEMPLOYEES 13 M TOTAL EMPLOYEES PER CATEGORY, NO NEGATIVES Yes
MOTE: FILERS SHOULD NOT REFORT ROWS WHERE NUMBER OF EMPLOYEES =0

19 TOTALHOURS 13 M TOTAL HOURS PER CATEGORY, NO NEGATIVES AND NO DECIMALS (.E., INTEGERS ONLY) Yes
EXCEPTION: TYPE & REPORT WHICH WILL REPORT "-3"

AN indicates alpha numeric data type, indicating that characters and numbers are allowed. N indicates numeric, indicating that only numbers are allowed in this field.
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Additional Reporting Requirement to Certify Uploaded Files
from EEOC Component 2 EEO-1 File Website

Once the Component 2 EEO-1 2017 or 2018 upload file has been accepted and validated, Employer-level data shown in Table 2
will be collected from filers directly through the Component 2 EEO-1 Online Filing System.

This information must be reported separately for each year for the employer’s report to be considered complete and certified

Given that it will be captured within the Online Filing System through an interactive web-based form, these items are NOT to be
included in the upload file

COMPUTER
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Additional Reporting Requirement to Certify Uploaded Files

from EEOC Component 2 EEO-1 File Website

TABLE 2. Component 2 EEQ-1 Employer-Level Data Collect in the Online Filing System After Successful File Upload

DATA. TIME FRAME MUST BE FOR OME YEAR ENDING IN THE SURVEY YEAR:
« 2017 COMPOMENT 2 EEQ-1 REPORT IS AN EMPLOYER-SELECTED PAY PERIOD BETWEEM OCTOBER 1,
2017, AND DECEMEER 31, 2017
« 2018 COMPOMNENT 2 EEC-1 REPORT IS AN EMPLOYER-SELECTED PAY PERIOD BETWEEN OCTOBER 1,
2018, AND DECEMEER 31, 2018

FIELD NAME VALUES, REMARKS, AND OTHER INSTRUCTION REQUIRED
REPORTING YEAR 2017 OR 2018 Yes
FEIN YOUR FEDERAL EIN (TAX 1D} 8 DIGITS Yes
QUESTION CA DOES THE ENTIRE COMPANY HAVE AT LEAST 100 EMPLOYEES IN THE PAYROLL PERIOD FOR WHICH YOU ARE Yes
REPORTING? 1=YES; 2=NO

QUESTION C.2 15 ¥YOUR COMPANY AFFILIATED THROUGH COMMON OWNERSHIP ANDVOR CENTRALIZED MANAGEMENT WITH Yes
OTHER ENTITIES IN AWM ENTERPRISE WITH A TOTAL EMPLOYMENT OF 100 OR MORE? 1=YES; 2=NO

QUESTION C.3 DOES THE COMPANY OR ANY OF ITS ESTABLISHMENTS (1) HAVE 100 OR MORE EMPLOYEES: (2) 1S NOT EXEMPT AS Yes
PROVIDED BY 41 CFR 60-1.5; (3) ARE PRIME CONTRACTORS OR FIRST-TIER SUBCONTACTORS, AND (4) HAVE A
CONTRACT, SUBCONTRACT, OR PURCHASE ORDER AMOUNTING TO $50,000 OR MORE, OR SERVE AS A
DEPOSITORY OF GOVERNMENT FUNDS IN ANY AMOLUNT; OR ARE FINANCIAL INSTITUTIONS WHICH ARE ISSUING
AND PAYING AGENT FOR U.5. SAVINGS BONDS ANDIOR SAVINGS NOTES? 1=YES, 2=NO

QUESTION DA THE WORKFORCE SMNAPSHOT PERIOD BEGINNING AND ENDING DATES USED FOR COMPEMSATION AND HOURS Yes

COMPUTER
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Additional Reporting Requirement to Certify Uploaded Files

from EEOC Component 2 EEO-1 File Website

FIELD NAME VALUES, REMARKS, AND OTHER INSTRUCTION REQUIRED

CERTIFYING OFFICIAL NAME | NAME OF THE OFFICIAL WHO CERTIFIES THE REPORTED DATA |15 ARE ACCURATE AND WERE PREPARED IN Yes
ACCORDAMCE WITH THE INSTRUCTIONS.

CERTIFYING OFFICIAL TITLE | TITLE OF THE OFFICIAL WHO CERTIFIES THE REPORTED DATA IS ARE ACCURATE AND WERE PREPARED IN Yes
ACCORDAMCE WITH THE INSTRUCTIONS.

COMNTACT PERSON MNAME OF THE INDIVIDUAL TO CONTACT REGARDING THE REPORT Yes

CONTACT PERSON TITLE TITLE OF THE INDIVIDUAL TO CONTACT REGARDING THE REPORT Yes

CONTACT PERSON ADDRESS OF THE INDIVIDUAL TO CONTACT REGARDING THE REPORT Yes

ADDRESS

CONTACT PERSON CITY CITY OF THE INDIVIDUAL TO CONTACT REGARDING THE REPORT Yes

CONTACT PERSON STATE STATE OF THE INDIVIDUAL TO CONTACT REGARDING THE REPORT Yas

CONTACT PERSON ZIP CODE | ZIP CODE OF THE INDIVIDUAL TO CONTACT REGARDING THE REPORT Yes

CONTACT PERSON PHOME NUMBER OF THE INDIVIDUAL TO CONTACT REGARDING THE REPORT; INCLUDE AREA CODE Yes

TELEPHOMNE NUMBER

CONTACT PERSON EMAIL EMAIL ADDRESS OF THE INDIVIDUAL TO CONTACT REGARDING THE REPORT Yes

ADDRESS

COMPUTER
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Document Version History
from EEOC Component 2 EEO-1 File Website

VERSION #

DATE

DESCRIPTION OF VERSION OR REVISION

1.0

07172019

Specification was created and released to the public.

11

08M6/2018

Specification was revised with the following changes:

+ Addition of a Document Version History Table and updated footer to Version 1.1

+ Clarification of report types required for single and multi-establishment employers, and additional description added on permissible report type combinations
within a file. This is described under the second bullet point in the Data Description section on Page 2

+ In TABLE 1, VALUES, REMARKS, AND OTHER INSTRUCTION comected text:

o COLUMN 15, “99: NOT APPLICABLE (TYPE 6 REPORT 6 OMLY)" cormected to "99: NOT APPLICABLE (TYPE 6 REPORT ONLY)"
« In TABLE 2, VALUES, REMARKS, AND OTHER INSTRUCTION comected text:

-

o CONTACT PERSON ADDRESS column: “TITLE OF THE INDIVIDUAL TO CONTACT REGARDING THE REPORT" corrected to *ADDRESS OF THE
INDIVIDUAL TO CONTACT REGARDING THE REPORT"

8/23/2018

Specification was revised with the following changes:

+ Under “Upload File Specifications.” the sentence “A single record with the column names is required” was made maore specific and bolded to emphasize this
requirement.

+ Instruction was added in TABLE 2, VALUES, REMARKS, AND OTHER INSTRUCTION:

o Inthe ZIPCODE column to provide guidance to user's constructing upload files in Excel.
o In the TOTALHOURS column to clarify integers, ie., whole numbers, are expected.

COMPUTER
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Part Il - eCMS

What’s New

Setup
EEO Category and Minority Mapping

Processing
Clearing Security for Co/Div will determine Single or Multiple Environment Reporting
New Menu Option and Selection Screens

CSV File Upload

New Component 2 Pay Data Format
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eCMS Setup

Payroll:
Minority Code Maintenance Mapping

Human Resources

Employee Personal Data

EEO Categories Mapping
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Minority Code Maintenance
Payroll > Maintenance 1 > Minority Code > Selection Screen

Payroll

Minority Code Maintenance

Company Number: 15

Division Number: 0 {

Minarity Code: 1

7N

Minority Codes have not changed

However, they must be mapped properly for the EEO-1 File

Prompt on the Minority Code field and you will see if your codes are mapped properly

PRP27601

PRPMOG - 22
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Minority Code Maintenance
Payroll > Maintenance 1 > Minority Code > Prompt Screen

PJC - Minceity Codes v P/R Minority Description Fie o = - 0 x
Minoeity Code Desc V T\ ££0-1 Report Fite Minod
I I | [ -
B — b Proper Minority Code Mapping
_ ) Minority Codes
0 Caucasian/VWhite 1
0. Hispanic or Latino
1 Mapanict atino must be mapped 0 1. White
2 Black | Alrican Ameckan 2 2. Black or African American
BIoRerlvohe 3. Native Hawaiian or Other
3 Hawal/Pacific Islandor 3 ree
EEO-1 Report File Paleflc Islander
4 Asian 4 4. Asian
Minority Column 5. Native American/Alaska
5 Native Amaerdican/Alaska Yy 5 Native
Native 6. Two or More Races
[ Two of More Races 6
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Minority Code Maintenance
Payroll > Maintenance 1 > Minority Code > Detail Screen

Payrall Minority Code Maintenance Mode: Update PRP27602 PRPMOS - 22
Minority Code: 0
Description: [Caucasian/White |
Champ Race: D
Minority Code Column: | ‘
EEO-1 Minority Code Column: |1 ! EEO-1 Minority Code Column Mapping Field

Minority Code/CC-257 Column: [0 |

COMPUTER
GUIDANCE

Smarter Construction. Cloud ERP.




Minority Code Maintenance Report
with EEO-1 Report File Minority Code Column Mapping

00/21/18  19:23:12

Mincrity Codes with Report Mapping

FETEED

PAGE 1

Src Com  Srec Div | Mincritys

Mo Mo Code

15
15
15
15
15
15
15

o O O O O O O

L A

EED-1 Report Min

Descripticn File Mincrity | Col

Code Column

Caucasian,/White
Hispanic/Latine

Black / African American
HawailifPacific Islander
Asian

MNative American/hlaska MNative

Two or More Races

LS T B S PRI W I o S

?/

4

* +#* END OF REPOCERT * *+ *

g

Query Report Created from PRTEEO File show
Minority Codes
Descriptions

EEO-1 File Minority Code Column Mapping

~

/

COMPUTER
GUIDANCE
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EEO Code Maintenance

HR > Maintenance > Description File > Type EEO Category > Selection Screen

Human Resources Description Master Maintenance
Company Number: 15
EEO Job Cat is th
ob ~ategory s the Division Number: 0 {
EEO Category in eCMS Description Type: |EEO Category ﬂ §
Description Code: i i]

HRP10001

Prompt to Select EEO Category

EEO Category Codes have not changed
However, they must be mapped properly for the EEO-1 File

Prompt on the Description field to confirm you have all EEO-1 Category Codes

HRPMO6 - 2

COMPUTER

Smarter Construction. Cloud ERP.
GUIDANCE




EEO Code Maintenance

HR > Maintenance > Description File > Type EEO Category > Prompt Screen

System Prompt

v ...

Cause Code

EE

H/R Description Master

Desc Code

EE
EE
EE
EE
EE
EE
EE
EE
EE
EE

Select Cause Code EE
To

Display EEO Codes

EE

L T < B I ¥ R T T R

-
=

99

Desc

Executive/Senior Level Officials/Managers
Professionals

Technicians

Sales Workers

Administrative Support Workers

Craft Workers

Operatives

Laborers and Helpers

Service Workers

First/Mid-Level Officials & Managers

Mot Applicable (TYpe 6 Report ONLY)

COMPUTER

GUIDANCE

Smarter Construction. Cloud ERP.




EEO Code Maintenance

HR > Maintenance > Description File > Type EEO Category

Human Resources

Description: EEQ Category

Description Master Maintenance

Code: 1
Description: Executive/Senior Level Officials/Managers
EEO-1 Job Category: 1

Mode: Update HRP10002

HRPMOG - 2

EEO Category Codes have not changed
However, they must be mapped properly for the EEO-1 File

Prompt on the EEO-1 Job Category Field to Map

COMPUTER
GUIDANCE

Smarter Construction. Cloud ERP.




EEO Code Maintenance

HR > Maintenance > Description File > Type EEO Category > Prompt Screen

System Prompt v

EEO-1 Job Category

1 Job Categories - =

-
v

2

j Prompt Screen Displays

5 Required

5]

S EEO-1 Job Category to Select for Proper
Mapping

8

9

10

a9

EEO-1 Job Descrniption

Executive/Senior Level Officials and Managers(Line No_ 1.1, Section D, on EEO-1

Form)

First/Mid-Level Officials and Managers(Line No_ 1 2 Section D, on EEO-1 Form)
Professionals

Technicians

Sales Workers

Administrative Support Workers

Craft Workers

Operatives

Laborers and Helpers

Service Workers

Not Applicable(Type 6 reports only)

COMPUTER
GUIDANCE
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EEO Code Maintenance Report
with eCMS Job and EEO-1 Categories Column Mapping

09/14/19

o
o]

15
15
15
15
15
15
15
15
15
15
15

Diwv
ji[a]

o o o o o o o oo o o O

09:19:18

Cause
Code

EE
EE
EE
EE
EE
EE
EE
EE
EE
EE
EE

Desc
Code

L e B v o ¥ L T T & N

R
WO

HE Description File

EEC-1 Codes with Job Category Mapping

2CMs EEC-1
Job Job Deascription
Category Category

1 1 Executive/Senior Lewvel 0fficials/Managers
2 3 Professionals

3 4 Technicians

4 E Sales Workers

5 [ Edministrative Support Workers

3 7 Craft Workers

7 8 Operatives

2 2] Laborers and Helpers

9 10 Service MWorkers
10 2 First/Mid-Level Cfficials & Managers
0 o] Mot Rpplicable (T¥pe & Report OQNLY)

Query Report Created from
HRTDSC & HRTDSCXT Files show
eCMS Job Categories
EEO-1 Job Category Mapping
Descriptions

Note: Desc Codes and eCMS Job
Categories are the same

COMPUTER
GUIDANCE
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Employee Personal D

ata

HR > Maintenance > Personal Data> General Screen

Human Resources Employee Data Maintenance Mode: Update HRP12001 HRPMOG - 4
Social Security Number: 330-33-0330 Employee Name: NY GIRL Unigue ID Number: 0
General General 2 Attendance Behavioral Prof | BenefitDeducti Benefits Select Comment Comp Time | Company Propert | Contact | Dependents | Educaton | Emp Deductions | Employment |
Events. Grievance History Ind i L Skills. Medical Memberships | Military Servic | O 1 Hist R R | salary Review | skill History |
Skill Inventory State/Local Termination His | Termination Lis Training uDC Vac/Sick/Gomp
Full Name: NY GIRL R , 330 B y
First Name: Y Verify Employee’s [
Middle Name 1: [ [
Middle Name 2: [ New York City
Last Name: GiBl » NY
ast Name: =l »Gender N T<]
Name Suffix: 56480
Name Abbreviatitin: GIRL MY
NYH H - B
Employee Class:| = »Minority Code Drivor's Liconse
Employee Type: < Employ¢ ooy |EH Number: |
Marital Status: 'V Single Comp; boo7  |EF Expiration: | -
Gender: [F Digisis »EEO Category = Class: 1
andicap Code" Debar 5 Issuing Authority: [
Minority Code: 6 <] 1 i = 101 i Heview: = Driver's License State:
Officer: No ~ . iral | Binh Date: 12/31/1945  |EH
Permanent Resident: Blood Type: Birth Place:
Benefit Group: [ B Insurance Plan: 0 Employee State: 330
Occupation: — Employee Local: B4
Occ. Description: [
Security Level: Country: 1 Emergency Contact
ACA Name:
Full Time Employee: [ ] Phone Number: o Gl
Full Time Date:
Plan Start Month: Manager: b T=] Supervisor:
1095C Line 14: Company: 0 Company:
1095C Line 16: Division: 0 < Division:
Produce Reporting:

COMPUTER
GUIDANCE

Smarter Construction. Cloud ERP.
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eCMS Processing

Human Resources
New Menu Option Selection Screen
Clear Security
Single Environment
Single Co/Div
Multiple Environment
Single Co/All Div
All Co/All Div

Note: Distribution Co/Div used to determine employees in workforce snapshot period

Smarter Construction. Cloud ERP. ﬁﬂ {F gf}




Create Component 2 EEO-1 Employer Data File

HR > Reports > Menu Option

Penny Chambers
15/000 - PC's Construction - 4.1

Create EEO-1 Employer Data File

Employee Benefit/Deduction Rpt

EEO Employer Info Report(EEO1)

FHWA 1391

HIPAA Certificate

OSHA 300 Report

OSHA 300A Report

- Te

wination history
Vets 100 Report
Vets 100A Report

Vets 4212 Report

Substance Abuse

Admin Archival BoM Comdata Copy Co Eq Acct Eq Maint ECM Forms G H/R H/R-E Imports
Prop Mgm PR -1 PR-C Rep Const REQ Service TaM Applicant o
ACA -
Benefit -
Cobra -
— Inquiry -
= B
e —
g
S — W Benefits or Deduction Employee Filter Reports >
I Create Component 2 EEO-1 Employer Data File Safety -

s P | =) “r

Inquiry

Jc

= P2

Ord Proc

>
P/IC

COMPUTER
GUIDANCE

Smarter Construction. Cloud ERP.




Single Environment Processing

Single Company / Division Security

Smarter Construction. Cloud ERP. ﬁm {F g



Create Component 2 EEO-1 Employer Data File

HR > Reports > Menu Option > Single Company / Division Security

Security — Single Co/Div

Environment

System Selection

Process All Companies: ) yes (@) no

Process All Divisions: ) yes @ no

Select C y and DI * [150 PC's Construction - 4.1
SoloatlBCC C

[ALL CEvELS Al LaVeIs - IND HeSCuoHS

7S

Single Co/Div Security
Leave Process All Companies = No

Leave Process All Divisions = No

Select Applicable Company and Division

systemSelection

COMPUTER
GUIDANCE

Smarter Construction. Cloud ERP.
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Create Component 2 EEO-1 Employer Data File

HR > Reports > Menu Option > Single Company / Division Security

Security — Single Co/Div

Human Resources Create EEO-1 Component 2 .csv HRP38001
HQ Company Number: 15
HQ Division Number: |j| <
Include Co{s)/Div(s) with a Common Federal ID#: 11-2233445

NORC User ID:

A 4

Workforce Snapshot Period:

y

. The System will Auto Populate these Fields
Users will Need to Input the Proper

Information for These Fields They are Protected Fields
NORC User ID and Workforce Snapshot

. Co / Div and Federal ID#
Period

COMPUTER

GUIDANCE Smarter Construction. Cloud ERP. E@ “(F y



Create Component 2 EEO-1 Employer Data File

HR > Reports > Menu Option > Single Company / Division Security

_ Security ~Single Co/Div

Human Resources

Select Pay
Period

Data Range
that

Incorporates all

Pay Frequencies

Create EEO-1 Component 2 .csv HRP38001
HQ Company Number: 15|
HQ Division Number: l l}-_
Iocludo Cole WDl el anith o T omonon Codocal IDH- A4 39324 AF
NORC User ID: 12345678
Workforce Snapshot Period: [tooirzor7 FE [ 12k12017 B
NORC User ID

Unique 8 Digit Identifier for the Entire Company Provided by NORC to Employer

Workforce Snapshot Period
Employers will choose 1 Pay Period to count Employees Job Category, Sex, Race or Ethnicity

Pay Period will be Chosen Between Oct. 1 and Dec. 31 of Reporting Year

COMPUTER
GUIDANCE

Smarter Construction. Cloud ERP.




Create Component 2 EEO-1 Employer Data File

HR > Reports > Menu Option > Single Company / Division Security

_ Security ~Single Co/Div

Human Resources Create EEO-1 Component 2 .csv HRP380C1
HQ Company Number: 15 HQ Division Number: 0
Include Co{s)/Div(s) with a Common Federal ID#: 11-2233445 NORC User ID: 12345678 Workforce Snapshot Period: 10/01/2017 12/31/2017
Co Div Unit# Company Name City State Zip County Name NAICS Code Question B2C Question D2
15 0 1234567 PC's Construction - Gold Canyon MD 12345 PINAL COUNTY 123456 1
i ; uestion B2C
Unit # County Name Required Q

Check = if You Filed Component 1

Populate with 1234567
NAICS Code Required Question D2

Will be Blank in CSV File and is 6 Digits Check Only = If all 3 Questions = Yes

IS THIS ESTABLISHMENT: (1) NOT EXEMPT AS PROVIDED FOR BY 41 CFR 60-1.5; (2) A PRIME CONTRACTOR OR FIRST-TIER
SUBCONTRACTOR; AND (3) HAVE A CONTRACT, SUBCONTRACT, OR PURCHASE ORDER AMOUNTING TO $50,000 OR MORE; OR SERVE AS
A DEPOSITORY OF GOVERNMENT FUNDS IN ANY AMOUNT; OR IS A FINANCIAL INSTITUTION WHICH IS AN ISSUING AND PAYING AGENTS

FOR U.S. SAVINGS BONDS AND OR SAVINGS NOTES? 1=YES; 2=NO

COMPUTER
GUIDANCE

Smarter Construction. Cloud ERP.



Create Component 2 EEO-1 Employer Data File

HR > Reports > Menu Option > Single Company / Division Security

Module Message Display CMS31601 APPM18 -4

The following CSV file has been placed in the IFS directory /cms/eeo: Up
loadFile201712345678.csv

Map Drive to Give Access and Authority to Files

Located in the IFS > Root > cms > eeo > csv files Mapping Drive Document Located on Our Website
This PC » CM5S 0A01.1111) (50 » eeo w0
-+ Mame Date modified Type Size
o @ UploadFile201712345678.csv /19,2019 G:00 PM Microsoft Excel C... 1KE
- H:| UploadFile201733333333.cav 9/19,/201%9 3:56 PM Microsoft Excel C... 1EKB
B:| UploadFile201855335533.cav 91972019 435 PM Microsoft Excel C... 1KB

COMPUTER
GUIDANCE

Smarter Construction. Cloud ERP.



Create Component 2 EEO-1 Employer Data File

Security — Single Co/Div

cms/eeo/csv file > Single Company / Division Security

iACS File Download will Replace a Mapping Drive — Slides 70 through 79

Single Co-Div 15-000 - PJC File for Doc 413.csv - Excel
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ACROBAT
— - - — D 13 -
% ca G KK == % Bweres B B 5 3 I iy i
P kB Copy - _ Co d' | Fo Cell IEEI EEEII Fo il Si & Find &
aste _ B I U~ === & 3= Merge & Center = $ -0 9 9 0 nditional rmat as nsert lete Format rt in
- ¥ Format Painter 9 "7 Formatting - Table- Styles- - - - & Clear~ Filter = Select -
Clipboard [F] Font [F] Alignment [F] MNumber [F] Styles Cells Editing
H - & 0 # 2505 i) :
Al - fv | userD
A B C D E F <] H | 1 K L Wl M =] P Q R 5
1 |USERID .ISTATUSCC UNITNUM UNITNAM UNITADDFUNITADDE CITY STATE ZIPCODE COUNTYN FEIN MNAICSCOLQUESTION QUESTION JOBCATEG RACEETHM ANNUALS TOTALEMITOTALHOURS
2 | 12345678 1 PC's Consil Easy Stre Gold Cany MD 12345 PINAL COL 1.12E+08 123456 1 2 11 1 1 80
3 | 12345678 1 PC's Consil Easy Stre Gold Cany MD 12345 PINAL COL 1.12E+08 123456 1 2 4c 1 3 400
4 | 12345678 1 PC's Consil Easy 5tre Gold Cany MD 12345 PINAL COL 1.12E+08 123458 1 2 5C 1 7 160
5 | 12345678 1 PC's Consil Easy Stre Gold Cany MD 12345 PINAL COl 1.12E+08 123456 1 2 1C 1 10 247

COMPUTER
GUIDANCE

Smarter Construction. Cloud ERP.
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Multi-Environment Processing
Single Company / All Divisions Security

Smarter Construction. Cloud ERP. ﬁm {F g



Create Component 2 EEO-1 Employer Data File

HR > Reports > Menu Option >

M

Environment System Selection

Process All Companies: ) yes (@ no

Process All Divisions: (@ yes () no

Select Company and Division: |35 U Company 35 v I

it a e ims el |ALL LEVELS - All Levels - No Restrictions ~|

L/ \J

Single Co/ All Div Security
Leave Process All Companies = No

Set All Divisions = Yes

Select Applicable Headquarter Company

systemSelection

88 PDPAJI:IFCE:FEQ Smarter Construction. Cloud ERP.



Create Component 2 EEO-1 Employer Data File

HR > Reports > Menu Option >

HRP38001

| P

|

Human Resources Create EEO-1 Component 2 .csv
IHQ Company Number: 35
HQ Division Number: _l]_]
Include Co(s)/Div(s) with a Common Federal ID#: 1
NORC User ID:
Workforce Snapshot Period: @ [ |@

Users will Need to Input the Proper Information for the following Fields
Headquarter Division Number
Federal ID #
NORC User ID

Workforce Snapshot Period Dates

The System will Auto Populate this Field
It is a Protected Field

Headquarter Company Number

COMPUTER
GUIDANCE

Smarter Construction. Cloud ERP.




Create Component 2 EEO-1 Employer Data File
HR > Reports > Menu Option >

_Security~Single Co/Div

Human Resources Create EEO-1 Component 2 .csv HRP38001
HQ Division Number: [ 70|
Include Co(s)/Div(s) with a Common Federal ID#: T 11-22334458]
NORC User 1Dz 12345678
Workforce Snapshot Period: L 10/31/2017 _ | 12/31/2017 _
Select Pay
Period Headquarter Division Number
Data;‘Range Common Federal ID # - IMUST be Exactly What is in PR Defaults (With Dash or Without)
that
NORC User ID
Incorporates all Unique 8 Digit Identifier for the Entire Company Provided by NORC to Employer
Pay Frequencies Workforce Snapshot Period

Employers will choose 1 Pay Period to count Employees Job Category, Sex, Race or Ethnicity

Pay Period will be Chosen Between Oct. 1 and Dec. 31 of Reporting Year

COMPUTER
GUIDANCE

Smarter Construction. Cloud ERP.



Create Component 2 EEO-1 Employer Data File
HR > Reports > Menu Option >

_ Security =Single Co/DIv

Human Resources

HQ Company Mumber: 35
Include Co(s)Div(s) with a Common Federal ID#: 11-2233445

Co Diwv Umnit# Companv Name

35 55 1234567 Moe Construction

35 70 1234567 RUTH PEPPERS INTL
Unit #

Populate with 1234567

Will be Blank in CSV File

Create EEO-1 Component 2 _.csv

HQ Division Number: 70
NORC User ID: 12345678

City State Zip County Name
Phoenix AZ 85204 MARICOPA COUNTY
SCOTTSDALE AZ 85262 MARICOPA COUNTY

County Name Required

NAICS Code Required
and is 6 Digits

HRP380C1

Workforce Snapshot Period: 10/01/2017 12/31/2017

MNAICS Code Question B2C Question D2

 123458] | ]
123458] = 1
Question B2C
Check = if You Filed Component 1

Question D2
Check Only = If all 3 Questions = Yes

IS THIS ESTABLISHMENT: (1) NOT EXEMPT AS PROVIDED FOR BY 41 CFR 60-1.5; (2) A PRIME CONTRACTOR OR FIRST-TIER
SUBCONTRACTOR; AND (3) HAVE A CONTRACT, SUBCONTRACT, OR PURCHASE ORDER AMOUNTING TO $50,000 OR MORE; OR SERVE AS
A DEPOSITORY OF GOVERNMENT FUNDS IN ANY AMOUNT; OR IS A FINANCIAL INSTITUTION WHICH IS AN ISSUING AND PAYING AGENTS

FOR U.S. SAVINGS BONDS AND OR SAVINGS NOTES? 1=YES; 2=NO

COMPUTER
GUIDANCE

Smarter Construction. Cloud ERP.




Create Component 2 EEO-1 Employer Data File

HR > Reports > Menu Option >

| Security =Single Co/Div

Module Message Display CMS91601 APPM18 - 4
The following CSV file has been placed in the IFS directory /cms/eeo: Up
loadFile201712345678 csv
Map D"V_e to Give Access and Authority to F!Ies Mapping Drive Document Located on Our Website
Located in the IFS > Root > cms > eeo > csv files
This PC » CMS0AI0TTI1T)(5:) » eeo v )
o
A Name Date modified Type Size
B:| UploadFile201712343678.cov 9/22/201910:52 AM  Microsoft Excel C... TKB
B:| UploadFile201812343678.cov 0/21/2019 243 PM  Microsoft Excel C... 3 KB

COMPUTER
GUIDANCE

Smarter Construction. Cloud ERP.




Create Component 2 EEO-1 Employer Data File

cms/eeo/csv file >

iACS File Download will Replace Mapping Drive — Slides 70 through 79

UploadFile201712345678 (6).csv - Excel
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ACROBAT
o . i pa— .
0 % Cut Calibri -l oA A - EPWrap Text General - z D.} &= &= ] 2 AutoSum Eadl ]

P BB Copy ~ Cond I F - Cell | Delete F [ Fin- Sort & Find &

aste r u - E Merge 8 Center - $ - a5 9 €0 .00 onditiona ormat as el nsert elete Format ort in

- ~ Format Painter g o Formatting -~ Table -  Styles - - - - £ Clear~ Filter - Select~

Clipboard = Font = Alignment = Mumber = Styles Cells Editing
H ©- i - - m E o=
Al - Jx || useriD
A B C D E F G H | J K L ¥ N s} P Q R s

1 |USERID _ISTATUSCC UNITNUM UNITNAM UNITADDF UNITADDF CITY STATE ZIPCODE COUNTYN FEIN NAICSCOL QUESTION QUESTION JOBCATEG RACEETHM ANNUALS TOTALEMI TOTALHOURS
2 | 12345678 3 RUTH PEPI123 RIKER SCOTTSDA AZ 85262 MARICOP, 222233445 123456 1 2 7C 1 1 382
3 | 12345678 3 RUTH PEPI123 RIKER SCOTTSDAAZ 85262 MARICOP, 222233445 123456 1 2 1A 1 1 40
4 | 12345678 3 RUTH PEPI123 RIKER SCOTTSDA AZ 85262 MARICOP, 222233445 123456 1 2 4D 1 1 384
5 | 12345678 3 RUTH PEPI123 RIKER SCOTTSDAAZ 85262 MARICOP, 222233445 123456 1 2 5E 1 1 40
5 | 12345678 3 RUTH PEPI123 RIKER SCOTTSDAAZ 85262 MARICOP, 222233445 123456 1 2 6 F 1 1 40
7 | 12345678 3 RUTH PEPI123 RIKER SCOTTSDA AZ 85262 MARICOP, 222233445 123456 1 2 8 A 12 1 674
8 | 12345678 3 RUTH PEPI123 RIKER SCOTTSDAAZ 85262 MARICOP, 222233445 123456 1 2 9G 1 1 156
9 | 12345678 3 RUTH PEPI123 RIKER SCOTTSDA AZ 85262 MARICOP, 222233445 123456 1 2 10 N 1 1 80
10 | 12345678 3 RUTH PEPI123 RIKER SCOTTSDAAZ 85262 MARICOP, 222233445 123456 1 2 2B 1 1 80
11| 12345678 3 RUTH PEPI123 RIKER SCOTTSDAAZ 85262 MARICOP, 222233445 123456 1 2 3C 1 1 20
12 | 12345678 4 Noe Consi626 E. 68th Phoenix AZ 85204 MARICOP, 222233445 123456 1 2 1G 1 1 282
13 | 12345678 4 Noe Consi626 E. 68th Phoenix AZ 85204 MARICOP, 222233445 123456 1 2 7D 1 1 800
14 | 12345678 4 Noe Consi 626 E. 68th Phoenix AZ 85204 MARICOP, 222233445 123456 1 2 3cC 1 1 848
15 | 12345678 4 Noe Consi626 E. 68th Phoenix  AZ 85204 MARICOP, 222233445 123456 1 2 5 A 1 1 48

COMPUTER
GUIDANCE

Smarter Construction. Cloud ERP.



Multi-Environment Processing
All Companies / All Divisions Security

Smarter Construction. Cloud ERP. ﬁm {F g



Create Component 2 EEO-1 Employer Data File

HR > Reports > Menu Option > All Companies / ALL Divisions Security

Security — All Co/Div
Environment sasion Selection systemSelection
Process All Companies: (@ yes () no
Process All Divisions: (@) yes () no
Select Company and Division: 5————"—7—
| "

All Co/Div Security
Set Process All Companies = Yes

Set Process All Divisions = Yes

Do Not Select a Company and Division

88 PDPXJCE:E Smarter Construction. Cloud ERP.



Create Component 2 EEO-1 Employer Data File
HR > Reports > Menu Option > All Companies / ALL Divisions Security

Security — All Co/Div

Human Resources

Create EEO-1 Component 2 .csv

HRP38001

HQ Company Number: o]

HQ Division Number: —U|
Include Co{s)/Div(s) with a Common Federal ID#: |
NORC User ID:

Workforce Snapshot Period: E'E

Users will Need to Input the Proper Information for All Fields

Headquarter Company and Headquarter Division

Federal ID #
NORC User ID

Workforce Snapshot Period

a

COMPUTER
GUIDANCE

Smarter Construction. Cloud ERP.




Create Component 2 EEO-1 Employer Data File
HR > Reports > Menu Option > All Companies / ALL Divisions Security

Security — All Co/Div

Human Resources

Create EEO-1 Component 2 _csv

HQ Company Number:

Select Pay
Period

Data Range
that

Incorporates all

Pay Frequencies

Workforce Snapshot Period:

15

HQ Division Number: | 0
Include Co(s)/Div(s) with a Common Federal ID#: | 11-2233445
NORC User ID: 12345678

10/01/2017 | [10/01/2017] = [EH

HRP38001

Common Federal ID # -

Headquarter Company and Headquarter Division Number

MUST be Exactly What is in PR Defaults (With Dash or Without)

NORC User ID

Unique 8 Digit Identifier for the Entire Company Provided by NORC to Employer

Workforce Snapshot Period

Employers will choose 1 Pay Period to count Employees Job Category, Sex, Race or Ethnicity

Pay Period will be Chosen Between Oct. 1 and Dec. 31 of Reporting Year

COMPUTER
GUIDANCE

Smarter Construction. Cloud ERP.




Create Component 2 EEO-1 Employer Data File
HR > Reports > Menu Option > All Companies / ALL Divisions Security

Security — All Co/Div

Human Resources Create EEQ-1 Component 2 csv HRP3380C1
HQ Company Number: 15 HQ Division Number: 0
Include Co(s)/Div(s) with a Common Federal ID#: 11-2233445 NORC User ID: 12345678 Workforce Snapshot Period: 10/01/2017 12/31/2017
Co Div Unit# Company Name City State Zip County Name NAICS Code Question B2C Question D2
13 o 1234567 Osborn Construction Mesa AF 85233 |MARIOCF‘A COUNTY | 123456] (]
15 0 1234567 PC's Construction - Gold Canyon MD 12345 [PINAL COUNTY 123456/ (|
35 55 1234587 Noe Construction Phoenix AZ 85204 [MARIOCPA COUNTY | | 123456| (|
35 ToO 1234567 RUTH PEPPERS INTU SCOTTSDALE AZ 85262 [MARIOCPA COUNTY 123456 (|
S0 1 [1234567 Karroll's Constructi Mesa--header-—18 AZ 85204 [MARIOCPA COUNTY _ 123456| (]
v 'y o A
- County Name Required  |¢—— . Question D2
Unit # Y q Question B2C Check Onl If all
q . . ec nly =ira
Populate with 1234567 . . . Check = if You Filed . y
NAICS Code Required and is 6 Digits 3 Questions = Yes

Will be Blank in CSV File Component 1 7

IS THIS ESTABLISHMENT: (1) NOT EXEMPT AS PROVIDED FOR BY 41 CFR 60-1.5; (2) A PRIME CONTRACTOR OR FIRST-TIER
SUBCONTRACTOR; AND (3) HAVE A CONTRACT, SUBCONTRACT, OR PURCHASE ORDER AMOUNTING TO $50,000 OR MORE; OR SERVE AS
A DEPOSITORY OF GOVERNMENT FUNDS IN ANY AMOUNT; OR IS A FINANCIAL INSTITUTION WHICH IS AN ISSUING AND PAYING AGENTS

FOR U.S. SAVINGS BONDS AND OR SAVINGS NOTES? 1=YES; 2=NO 4

COMPUTER
GUIDANCE
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Create Component 2 EEO-1 Employer Data File
HR > Reports > Menu Option > All Companies / ALL Divisions Security

Security — All Co/Div

Module Message Display CMS91601 APPM18 - 4

The following CSV file has been placed in the IFS directory fcms/eeo: Up
loadFile201712345678.csv

. . . . D
Map Drlv-e to Give Access and Authority to F!Ies Mapping Drive Document Located on Our Website J
Located in the IFS >‘Root > cms > eeo > csv files |
v
PC » CPMSMI0T1T113 (%) » eeo w | 0

Mame Date modified Type Size
Bz UploadFile2017123456878.cov 9/22/20019 10:52 AM Microsoft Excel C... TEE
Bz UploadFile201812345678.cov 8/21/2019 3:43 PM Microsoft Excel C... IKB

88 PDPAJI:IFCE:FEQ Smarter Construction. Cloud ERP.



Create Component 2 EEO-1 Employer Data File
HR > Reports > Menu Option > All Companies / ALL Divisions Security

Security — All Co/Div iACS File Download will Replace Mapping Drive — Slides 70 through 79

UploadFile201712345678 (4).cov - Excel
HORME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW ACROBAT
] FTE Z:‘ . Calibri o AR - A -2 - =7 Wirap Test General - [ PILII = = | 3= =< [ % :‘I’I‘f"‘“"" 2 il
PSS o rarmat Painter | B T M - - T T mm s ElMememcenter - - %e xSl B e Tabie o seplenn ot PSS FOINSE e Crear- Fiter s serers
Clipbaard = Fant = Aligrment - Mumber = Styles Cells Editing
H - e g [ O - D - S S
AL - I USERID
A 3 < o E F s H 1 3 [ L ra r~ =} [ a R s T
1 [USERID  ISTATUSCC UNITNUM UNITNAM UNITADDF UNITADDE CITY STATE ZIPCODE COUNTYMN FEIN NAICSCOL QUESTION QUESTION JOBCATEG RACEETHR ANNUALS TOTALEMI TOTALHOURS
= [1z3asers 3 PC's Constl Easy Stre Gold cany MD 12345 PINAL COY 112233445 1z3as6 1 2 8 F 1 1 s0
= | 123458678 B PC's Constl Easy Stre Gold Cany MD 12345 PINAL COL 112233445 123as6 1 2 EILY] 1 1 =0
2 | 12345878 3 PC's Consil Easy Stre Gold Cany MD 12345 PINAL COL 112233445 123as6 1 2 a 1 1 =0
5 | 12345578 3 PC's Constl Easy Stre Gold Cany MD 12345 PINAL COl 112233445 123456 1 2 aE 1 1 80
& | 123458678 a PC's Cons1l Easy Stre Gold Cany MD 12345 PINAL COY 112233445 123456 1 2 s c 1 1 as
7 | 12345878 a Osborn Cc 7241 E Mar mesa Az 85233 MARICOP, 112233445 123as6 1 2 2 c 1 2 =0
a | 12348878 a Osborn Cc 7241 E Mar Mesa az 85233 MARICOP, 112233445 123as6 1 2 &L B 1 667
o | 12345578 a PC's Constl Easy Stre Gold cany MD 12345 PINAL COl 112233445 123456 1 2 8 F 1 Y =0
10 | 123as678 a PC's Consil Easy Stre Gold Cany MD 12345 PINAL COL 112233445 123as6 1 2 Bl 1 1 =0
11 | 123a5578 a PC's Constl Easy Stre Gold Cany MD 12345 PINAL COl 112233445 123456 1 2 s 1 1 =0
12345678 a PC's Constl Easy Stre Gold Cany MD 12345 PINAL COL 112233445 123456 1 2 aE 1 1 80
12345678 a PC's Const1l Easy Stre Gold Cany MD 12345 PINAL COY 112233445 123456 1 2 s c 1 1 as
12345678 a MNoe Cons! 626 E. 68t Phoenix AZ 85204 MARICOP, 112233445 123as6 1 2 1G 1 1 282
12345678 a MNoe Consi 626 E. 68t Phoenix Az 85204 MARICOP, 112233445 123456 1 2 7 D 1 1 s00
12345578 a MNoe Cons! 626 E. 68t Phoanix AZ 85204 MARICOP, 112233445 123456 1 2 o c 1 1 848
12345678 a Noe Const 626 E. GatF Phoenix AZ 85204 MARICOP, 112233445 123456 1 2 S 1 1 as
12345678 a RUTH PEPI 123 RIKER SCOTTsSDe AZ 85262 MARICOP, 112233445 123as6 1 2 7 c 1 B azs
12345678 a RUTH PERI123 RIKER SCOTTSDA AZ 85262 MARICOP, 112233445 123as6 1 2 1 a 1 1 ao
12345678 a RUTH PEP| 123 RIKER SCOTTSDA AZ 85262 MARICOP, 112233445 1234585 1 2 a D 1 1 3ma
12345678 a RUTH PEPI123 RIKER SCOTTSDAAZ 85262 MARICOP, 112233445 123456 1 2 s E 1 1 a0
12345678 a RUTH PEPI123 RIKER SCOTTSDe AZ 85262 MARICOP, 112233445 123456 1 2 s F 1 1 a0
12345678 a RUTH PEPI 123 RIKER SCOTTsSDe AZ 85262 MARICOP, 112233445 123as6 1 2 EIPN 12 1 67a
2 | 12325878 a RUTH PEPI123 RIKER SCOTTSDE AZ 85262 MARICOP, 112233445 123as6 1 2 2 G 1 1 1s8
5 | 12345878 a RUTH PEPI 123 RIKER SCOTTSDa AZ 85262 MARICOP, 112233445 123456 1 2 10 ™ 1 1 =0
26 | 12345678 a RUTH PEPI123 RIKER SCOTTSDe AZ 85262 MARICOP, 112233445 123456 1 2 28 1 1 80
27 | 1z3as678 a xarroll's © 1046 E. 9tk mMesa--he. Az 85204 MARICOP, 112233445 123as6 1 2 10 ma 3 Y aas
25 | 12345678 a Karroll's C 1046 E. 9t rMesa-—he, AZ 85204 MARICOP, 112233445 123456 1 2 2 3 1 1 22
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iSeries Access Client Solutions
iACS Download
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iIACS — File Download

Replaces Mapping a Drive

e — O >
File Edit View Communication Actions<€irreermr—tlcir

== Data Transfer To IBM i...
% By @ .,L i E @ = Data Transfer From [BM i... - 2 &

. . A
Mawvigator for i...

Printer Qutput
Schemas

Run 50L Scripts Select the Action Menu Option
S0L Performance Center

Popup Keypad...

Highlight Integrated File System

Macro
Tab

Click — One Time
Screen History

Record Playback...
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iIACS — File Download

Replaces Mapping a Drive

& o 1011111 — —_ e
File Edit Wieww Acticns
10.1.1.1311 ~ Filte=r =
Directory
b T ~
= = ™
Toom MrMames= - Size (KEX Last Modified
ALCHOr March 2, 2016 S:35:05 PM MST
= bir May 1<, 2019 12:25:56 AM MST
bin. prw . . . February 22, 2012 1:52:0% PMM MST
] P This Screen will Allow you to Select the Directory Path T [ et Lt
oms September 200, 20019 S:57F: 5<% AlM MST
cmiswesotl May 13, 2019 12:22:39 AMM MST
=] dailwlog. t=t . 2= March <%, 2016 2: 10:01 P MST
= =t See Next 2 Slides to Setup the 1 October 18, 2010 5:12: 29 PM MST
desw February 25, 2019 3:<940: 37 PM MST
eforms May 13, 2019 12:22:39 Al MST
eforms—Jawva P hf May 1<%, 2019 12:09:55 arv MST
=t ath for CmS/eeO February 25, 2019 <40 1:0<1 PR MST
Ffixes Avugust F, 2015 S:01:5<3 P MST
FL May 13, 2019 11:2<%: 58 PV MST
antc May 1<, 2019 12:09: 58 Al MST
- o=

S0 obijsects

o

Messages
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iIACS — File Download

Replaces Mapping a Drive

Y on 1011111 = —
File Edit Wiew Scticons
A0.1.1.111 —— Filb=r =T
Directorw
z T ~
- - P
Toom MMams= - Size (KB Last Modified
AL O March 2, 2015 S:35:05 FM MST -
= bir May 13, 2019 12:28:5&5 AM MST
bBir . prew Select - cms Februsry 22, 20129 1:5Z2:09 P~ MST
L3 catalima.out
crmswwe sl Maywy 1<, 2019 12:22: 39 &AM MST
= R s Al Click Once to Highlight Y OCtober 18, 2010 511229 fra MsT
erbyv . log = =r - = =
desw February 25, 2019 3:<30: 37 P MST
eforms Mayw 13, 2019 12:22: 39 AlM MST
eforms-iawa Click Twice to Select MaI:- 1=, 2019 12:09: 55 AM MST
=eto February 25, 2019 $:01:0=9 P MST
fixes August F, 2015 S:01: 59 PR MST
FL May 135, 2019 11:2<%: 58 FPM MST
gritc May 1<%, 2019 12:09: 58 AM MST et
- >

S0 objects

e,

Messages
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iIACS — File Download

Replaces Mapping a Drive

S o= o 1001010711 — — -
File Edit Wiswvw Scticns
1. 1.31.3111 S Filte=r =T
Clirectory
JFo— L -
- = |

Tcom FrMame Size (KB Last Modified
aca March &, 2017 <:03: 13 P MST
ApCH Select — eeo Mayw 1<%, 2019 12:22: 3% A MST
arPPaidCheckData Mayw 1<%, 2019 12:22: 35 AM MST
avibeEmp September 20, 2019 S:19:57F AM MST
Certfied_ PR April 28, 20168 F:19:57 AMM MST
I Click Once to Highlight ptember 20, 201D 12:59:99 PM MST
eForms February =, 2011 12:22: 37 P+ MST
eformsJawa March 11, 2015 3:Z21: 35 P MST
EFT May 1%, 2019 12:22:3F5 AM MST
eMAaARS CI|Ck TWiCE to se|ect May 1<3, 2019 12:22: 39 &AM MST
Equipmentiisags March 20, 2018 3:30:<3%3 P MST
I& April 18, 2019 7F:28:11 PM MST
LCPT May 1<%, 2019 12:22:3F5 AM MST
LCPT-D april 5, 2019 1:13:53 FM MST
MagMMedia January 23, 2013 1:18:05 P MST

- >

21 objects

s,

Messages
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iIACS — File Download

Replaces Mapping a Drive

SCrrmss esc o - - - JE—
- - 10011111 = —

File Edit “Wiew Sctions Previous Refresh

10.1.1.31311 — | I Filc=r =

Directory [P Directory is now /cms / eeo
I_."crns_."eech P, I L il
- > P ™
com rHam= —— Size (KE) Last Modifi=d
B3 UploadFile20 17123456 73 .cswv 1 September 20, 20129 2:55: 23 PM MST
E3| UploadFile20 18 123456 78 .cswv 1 September 20, 20129 2:53: 36 PM MST

\ 4

A List of Available Files Will be Displayed

- =

2 objects

i,

Messages

COMPUTER

GUIDANCE Smarter Construction. Cloud ERP. E@ ‘ﬁ gy



iIACS — File Download

Replaces Mapping a Drive

@‘ JomsSesec on 10077711
File Edit Wiew Acticons

10.1.1.11311
Directory

— Filcer

2" — Right Click the Highlight the File

a

4

3rd — Select Download — Click Once

A

Download and Wiews
Upload...

Copy

Paste

Send...

Permissions

Wieww

2 obj=scts

Properties

Somsfe=o L 2l
< > |
Icom rMams o~ Size (KB} Last Modified
[« En UploadFile 201712345678 . csw september 20, 2019 2:56: 23 PM MST
[ En UploadFile 2018123456 78, csw Mews Folder... september 20, 2019 2:53:36 PM MST
kv Drelete
1st - Highlight the File Rename...
4 Dowwnload

[ Steps to Download a File
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iIACS — File Download

Replaces Mapping a Drive
i crisreec on TOLT.T0TT1 — v
Fil= Edit “Wieww Sctions
10.1.31.313131 — I I Filter >
Drirectory
| femsse=o ] L -l
— = [
Icon rame —~ Size (KB Last Modified
[ = [w| UploadPile20 1712345678 . csw & Download e
=< En| UploadFile20 18 123956 78 . csw 1 September 20, 2019 2:53: 3 P MST
Dowwnload the objects showvern belowe -
Sorce
" . . Somsfeeo
Confirmation on File to Download
Destimaton:
CrZWiserstochambersWhesktop
Click - OK Icom rams=
Bl UploadFile20 1712345575, .
- >
» (=] 14 i | Cancel |
- | b
Z obijscts
e
Messages
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iIACS — File Download

Replaces Mapping a Drive

S crmsfesc on 10.7.7.711 — — =
File Edit Wiew Scticns

A0.1.1.1311 ~— Filte=r =<

Directory
| femssie=o | L -l
< > P ™

Toom rName - Size (KB Last Modified
LiploadFile 220 171 23355 78 . csw
UploadFile20 18 1234956 78.csWw 1 September 20, 2019 2:53:36 PM MST

El=]
L E|

Confirmation Your File Was Successfully Downloaded

Downloading UploadFPFileZ2Z0l 7123495678 @0 cos W
Suncocae==sFfuxald A W AdAowmniloadaed TeloasadFPFilae201 71234945678 0 oS~

a

COMPUTER

GUIDANCE Smarter Construction. Cloud ERP. ﬁlﬁ} c{ﬁ g;? @



Smarter Construction. Cloud ERP. ﬁm {F 5’




Helpful Tips!

Setup

Map Minority and EEO Category Codes

Employees MUST have both codes setup in their Personal Data General Tab

Minority Code File is PRTEEO

EEO Category Files are HR Description (HRTDSC) and HR Description Extension (HRTDSCXT)

Note: IDI is being developed for both these options but is not currently ready J
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Helpful Tips!

Processing
Workforce Snapshot Period
Select pay period that incorporates all frequencies
Choose period between Oct. 1 and Dec. 31 of the reporting year. 2017 and 2018 do not have to be the same period
Time Card History File (PRTTCH) will be used to determine
Weekend Date — Workforce Snapshot Period

Distribution Company and Division - Employees to be reported
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Helpful Tips!

Processing
Source Company and Division:
Determine employee’s minority code, EEO (job) category and sex
File HR Personal Master (HRTEMP)
Determine employee’s reported W2 FIT wages for Pay Bands and Hours

File PR Earnings File (PRTERN)
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Helpful Tips!

Processing
Security Clearance:
Single Environment use Single Company / Single Division — System will populate Headquarter Company / Division and EIN
Multi-Environment use either

Single Company / All Division — System will populate Headquarter Company used to clear security
Headquarter Division and EIN must be entered

All Companies / Divisions — User must populate Headquarter Company, Headquarter Division and EIN
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Helpful Tips!

Processing
Security Clearance:
Single Environment use Single Company / Single Division — System will populate Headquarter Company / Division and EIN
Multi-Environment use either

Single Company / All Division — System will populate Headquarter Company used to clear security
Headquarter Division and EIN must be entered

All Companies / Divisions — User must populate Headquarter Company, Headquarter Division and EIN
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Helpful Tips!

Processing

e I hitp://as410.cgent.com:44300/ecms/cms/menu/displ O ~ & || 3B eCMS ERP by CGC LT
File Edit View Favorites Tools Help

3 3

S5 5 Systemn Selection (2) 2] Computer Guidance 5 System Selection 3% Payroll Education, Payroll ... &2 https-—-www.adp.com-—... ™ Revenue Quebec - Partner [ ~ [=] deh ~ Page~ Safety~ Tools~ @~
Penny Chambers r
N 15/000 - PC's Construction - 4.1 0.0 & © ? X
AP AR Admin Archival BoM Comdata Copy Co Eq Acct Eq Maint ECM Forms GiL H/R H/R-E Imports Inquiry JIC Ord Proc PIC PIC-2

PO PIS Prop Mgm PR I*l PR-C Rep Const REQ Service T&M

Module Message Display CMS91601 APPM18 - 4

There were no records selected to process

You will receive the following message if there is no data found for your selection
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Helpful Tips!

CSV File
New Menu Option to create the file
HR > Reports > Create Component 2 EEO-1 Employer Data File
The file will replace with the last one created
No historical CSV files just the most current to send to EEO
Two options to access CSV files in IFS
Map a Drive in to cms/eeo

New — Client Access Solutions — iACS Download — see slides 70 through 77
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Thank You
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